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1. Desktop, Icons and using windows
1.1.

Outline the purpose of the desktop and the task bar

The Desktop is the first screen you see in your computer after Windows is loaded. And it always stays
there (sometimes underneath other windows) until you shut down your computer. The Purpose of the
Desktop is to provide icons such as Recycle Bin, Shortcuts which you have created and more.

Figure 1: Example of a desktop.

The purpose of the taskbar is to provide the user with an easy way of opening and managing programs
installed on their computer.

1.2.

Identify common icons like those representing: files, folders, applications,
printers, drives and shortcuts/aliases, recycle bin/trash/wastebasket

Desktop Icons

Examples

Files

Folders
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Desktop Icons

Examples

Applications

Printers

Drives

Shortcuts
Shortcut symbol

Recicle Bin/
wastebasket/ Trash

My computer
Table 1: Common icons

Open icons
Select the icon you which to open and double click with the left button of the mouse.
Select and move icons
Click on the icon to Select it and then drag it to where you need the icon you can also use Cut, Copy and
Paste techniques.
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1.3.

Create, rename, move, a shortcut

Sometimes it might be necessary to create a shortcut on the desktop. Usually the reason behind this is
that you use a particular file / folder on a regular basis and you want to be able to open it easily and
quickly.
To Create a New Shortcut:




Right click on a file / folder.
Move the pointer to send to.
Click Desktop (Create Shortcut). A shortcut to that file / folder will be created on the desktop.

Figure 2: Creating shortcut

Move a Shortcut to another Location on your Computer





Right click on a file / folder.
Click create shortcut.
The shortcut will be created next to your selected file / folder.
Move the shortcut to the desired location. (Using cut & paste or drag & drop techniques).
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Figure 3: Moving shortcut

Rename a shortcut or Delete a Shortcut



Right click on the shortcut.
Click on Rename to change the name of the Shortcut or Delete if you want to remove the
shortcut.

Figure 4: Rename and delete shortcut
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1.4.

Identify the different parts of a window: title bar, menu bar, toolbar, ribbon,
status bar, scroll bar

Figure 5: Different parts of a window

Figure 6: Options of a window

1.5.

Switch between open windows

If you have windows open, but they are minimized, you can restore them quickly and easily. All you
need to do is click on the window that you want to open, displayed in the taskbar.
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If you want to switch between two open windows i.e. if you have one open but want to view another
that is minimized, simply click on the application icon and then choose from the files you have opened

Figure 7: Switching windows

1.6.

Information about the computer

That My Computer or This Computer (PC) folder sitting at the top of your desktop is a useful,
multipurpose tool. The My Computer folder is a gateway to all the data stored on the computer,
attached devices, and the network -- as well as a shortcut to most of your system information. It also has
shortcuts to system updates and restoration features.
Locating the Folder
The My Computer (This PC) folder can be accessed in three different places on the computer and does
exactly the same thing in all three places. You can find the My Computer folder on the computer's
desktop, on the Start menu and within Windows Explorer. The desktop icon may be hidden if you have
configured desktop settings to hide all icons.

Figure 8: This PC
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Windows Explorer
The My Computer folder's primary purpose is to provide a shortcut to Windows Explorer. You can open
Windows Explorer to a system-level display by double clicking or right-clicking and selecting "Open" on
the My Computer folder. Windows Explorer is the tool you use to browse all files on the computer. It is
commonly used to sort and store documents, pictures, music and video files on the computer as well as
to transfer information between the computer and connected devices. The system-level window
displays all the hard drives, external drives and storage cards connected to the computer. It can also
display shortcuts to other computers on the network.
Computer Information
The My Computer folder also provides a shortcut to a window with system information. You can open
this window by right-clicking on the My Computer folder and selecting "Properties." The "General" tab
provides basic information about your computer, for example Windows edition, System, Computer
name, domain, workgroup setting and windows activation.

Figure 9: Information about computer

12 | P a g e

Another way of having access to the information the My Computer (This PC) folder is to double click the
left button of the mouse, on the icon “My Computer” (This PC).

Figure 10: Opening My Computer with double click

Storage information
In order to have knowledge of the storage capacity of your computer you should double click on the
folder My Computer (This PC) and select System properties.

Figure 11: System properties
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The Settings window will open and you should choose Storage, and all information regarding the
computer’s storage will be displayed.

Figure 12: Storage information

14 | P a g e

2. Working with text
2.1.

Open, close a word processing application. Open, close files

Opening a Word Processing Application





Click on the Start Button
Click All Programs
Select Microsoft Office
Click on Microsoft Office Word

To close a Document / Microsoft Word



Click the Microsoft Office Button and click close, Close. OR
Otherwise click on the small ‘x’ button

Opening an Existing Document




Click the Microsoft Office Button and Click Open, or Press CTRL+O (Depress the CTRL key while
pressing the ―O‖) on the keyboard
Choose the location where the file is Saved
Click on the file and Click Open

2.2.

Enter text into a document

Flashing insertion point indicates where the next character you type will appear. Simply start typing to
enter text. If you make any mistakes, use the Backspace key to delete unwanted characters.

2.3.







Copy, move text within a document, between open documents. Past a screen
capture into a document

Select the text that you wish to copy.
Click on the Home tab and select Copy
Click at the position within the document where you wish to
paste the copied text. If you wish to paste it in another
document, click on the document window on the taskbar.
Click on the Home Tab again and Select Paste.
Figure 13: Past button
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Move text within a document or between open documents.






Select the text that you wish to move.
Click on the Home tab and select Cut
Click at the position within the document where you wish to paste
the copied text. If you wish to paste it in another document, click
on the document window on the taskbar.
Click on the Home Tab again and Select Paste.

Figure 14: Past and cut button

Paste a screen capture into a document



Locate the print screen button on your keyboard and press it once. This will take a picture of the
current screen.
Click Paste.

Figure 15: Print Screen button on keyboard and Paste button




If you only need to capture a copy of the active window, press Alt from your keyboard and press
the print screen button, whilst holding the Alt key.
When you click Paste in an application, you will see that only the active window will be pasted
and not the whole screen

Figure 16: ALT and Print Screen button on keyboard and Paste button

2.4.



Save and name a document
Click the File Button
Click Save or Save As
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Figure 17: Save a document.



Or
Press CTRL+S (Depress the CTRL key while pressing the ―S‖) on the keyboard,
OR
Click the Save icon on the Quick Access Toolbar



Write the name of the document in the file name field then click Save



Figure 18: Name a document.

2.5.

Install, uninstall a printer. Print a test page

Install a Printer



Click Start button.
Click Control Panel.
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Figure 19: Start button and Control Panel button



Click on Devices and Printers

Figure 20: Devices and Printers’ button



Double-click Add Printer to start the Add Printer Wizard, and then click next.

Figure 21: Add Printer button



Follow the on-screen instructions to finish the wizard.

Uninstall a printer



Click Start button.
Click Control Panel.

Figure 22: Start button and Control Panel button
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Click on Devices and Printers

Figure 23: Devices and Printers’ button



Click on Remove Device and Click Yes

Figure 24: Remove device

Print a test page







Open Printers by clicking the Start button Picture of the Start button
Then click Control Panel
Click Hardware and Sound,
And then click devices and Printers.
Right-click the printer that you want to test, and then click Properties.
On the General tab in the Printer Properties dialog box, click Print Test Page.

2.6.

Set a default printer from an installed printer list

Normally in a computer network environment, there will be several printers.
Users will therefore need to send their documents to a specific printer – probably to the printer closest
to their computer system. Such users will set this printer as the default printer. The default printer is the
printer to which a computer sends documents when you select the Print command without first
specifying which printer you want to use with a program. You can have only one default printer; it
should be the printer you use most often.
To set a printer as the default printer:



Click Start button.
Click Control Panel.
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Figure 25: Start button and Control Panel button



Click on Devices and Printers

Figure 26: Devices and Printers’ button




Right-click the name of the printer to set as a default printer.
Click Set as Default Printer.

Figure 27: Set a Default Printer
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2.7.




Print a document from a word processing application

Click on the File Button.
Point to Print.
The Print dialog box will be displayed as illustrated below.

Figure 28: Print dialog box

In the Page range section choose whether you wish to print all the pages in the document, the current
page only, selected pages, or a particular selection.
In the Copies section specify how many copies of the same document you wish to print.

Figure 29: Number of copies

You can choose to print all the pages in the range specified, or else you can choose to only print the odd
or the even pages.
Finally, click PRINT.
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2.8.

View, pause, restart and cancel a print job

View a Print Job





Once you have started printing you can view a print job’s process.
Double click on the printer icon displayed at the bottom-right of your screen.
This will display a dialog box showing the progress of your print jobs.
Otherwise, from the Control Panel, click on Printers, then double- click on the printer in use.

Figure 30: Dialog box showing the progress of your print jobs

Pause, Restart or Cancel a Print Job



Open to View the Print Job Progress
Right click on the file you want to cancel, pause or Restart and choose from the Menu given

Figure 31: Menu when right clicking on the file
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3. Introducing files and folders
3.1.

Understand how an operating system organizes files, folders, files in a
hierarchical structure. Navigate between drives, folders, sub-folders, files.

What are Drives, Folders and Files?
When accessing a drive on your computer, Windows uses a system of drive letters to serve as logical
pointers to the different physical drives you have access to. From each drive letter it is possible to access
all of your files stored on that particular physical drive. For instance, the Hard Disk drive letter is usually
‘C’. On some computers, you will find two hard disks, one of which will be the C drive and the other will
be the D drive. The Floppy Disk is referred to as drive A. Pen drives are referred to as Removable Disks
and they may be assigned different letters, depending on the number of disks installed on your
computer.
To help organize your files it is possible to create folders (also referred to as directories) to help divide
and even sub-divide the files stored within the various logical drives available. A system of hierarchical
folders within folders which represent your hard disk are often referred to as the folder (directory) tree,
in the same way the very top of the file system is known as the root folder (directory). Finally, at the
very end of this structure are the various files which we use. Each file name can be up to 255 characters
in length.

3.2. Display file, folder properties like: name, size, location



Right click on the folder.
Click Properties.

Figure 32: Folder properties
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3.3. Change view to display files and folders like: files, icons, list and details
Open the Folder and click on the View tab on the right-hand side of the screen and choose between
tiles, icons, list and details.

Figure 33: View to display files and folders

3.4.

Identify common file types like: word processing, spreadsheet, presentation,
portable document format, image, audio, video, compressed, executable files.

Within the Windows Explorer window each file will be marked with a small icon, as illustrated. In the
example shown, the first file displays an icon representing PDF, and if you look along the line of
information about this file, it clearly states (assuming that you are using the details mode to view the
files) that the file is indeed a PDF file. The second file is marked as a Microsoft Word file in the same
way.

Figure 34: Example of files
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File extensions
File names usually end with a 3-character extension. A period (.) separates the filename from the file
extension. Some of the common file extensions are listed below:
File Extension
.doc
.rtf
.txt
.xls
.ppt or .pps
.mdb
.bmp
.gif
.jpg
.wav
.mid
.mpe, .mpg
.avi
.zip/ .rar
.tmp
.exe

3.5.

File type
MS Word document
Word processing program – Rich Text Format
MS Notepad – Text file
MS Excel workbook
MS Powerpoint file
MS Access database
MS Paint Bitmap Image
Graphics Interchange Format (image)
Joint Photographic Experts Group (image)
Wave file (sound)
Midi file (music)
MPEG animation
MS video for Windows movie
Zipped/ compressed file
Windows temporary file
Executable file
Table 2: File extensions

Open a file, folder, drive

To open a File, folder or drive, double click on it.

3.6.

Create a folder

Recognize good practice in folder, file naming: use meaningful names for folders and files to help with
searching and organization.










Create file names that are logical, meaningful to all users, simple to read and relevant.
Use lowercase when naming files.
Do not use the following characters: &, ( ) % # â€˜ â€oe / \ - { } [ ] < > @
When numbering similar types of files or sequences try to anticipate maximum numbers
Files should not be located in directory structures with more than six levels, as this can create
difficulties when accessing and archiving files.
Identify the area where you will create your new folder, e.g. Desktop or My Documents.
Right click in an empty space, point to New, and then click Folder.
A new folder will be created and you can use the keyboard to type a name for the folder.
Press Enter
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Figure 35: Create folder

3.7.





Rename a file, folder

Right click on the folder / file.
Click Rename.
Type in a new name.
Press Enter

Figure 36: Rename file
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3.8.

Search for files by properties

To open the Search dialog box, click on the Start button, and write the file/folder where you have Start
Search and click on See more results.

Figure 37: Search dialog box

To search for a file using wildcards instead of the full name.
In the previous example, we knew the full name of the file or folder for which we were searching. In
some cases, we may only know part of the name, in which case we can use wildcards.
For example:





To search for all files whose names start with z
Type: z*
To search for all files whose names start with za
Type: za*
To search for all files whose names start with za and contain 5 characters
Type: za???
To search for all Microsoft Excel files whose names start with za and contain 5 characters
Type: za???.xls

3.9.


Select individual, adjacent, nonadjacent files, folders

To select an individual file / folder simply click once on the file / folder. The file / folder
will be highlighted in blue.
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To select a number of adjacent files / folders. Click on the first file / folder in the block
you wish to select, then press Shift and keep holding the key whilst clicking on the last
file / folder in the block.

Figure 38: Select a number of adjacent files / folders



To select a number of non-adjacent files / folders. Click on the first file / folder that you wish to
select. Then press and hold the Ctrl key, whilst clicking on the other files / folders that you wish
to select.

Figure 39: Select a number of non-adjacent files / folders

3.10. Sort files in ascending, descending order by name, size, type, date modified
The files displayed This PC window can be sorted by name, size, file type and the date/time last
modified:
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Figure 40: “This PC” window



Click View, Details.

Figure 41: View menu



Click the appropriate header:

Figure 42: Sort files

Note: To reverse the sort order, re-click the appropriate header.
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Counting the Number of Files of a particular type in a Folder




Let’s say you have a folder that contains files of different types and you want to know the
number of files that are of the type .txt (text files). Follow these steps:
Set the view to Details.
Sort the files by type.

3.11. Copy, move files, folders between folders, drives




Select the files / folders that you wish to duplicate / move.
Right click on the file or folder to Copy (to duplicate) OR Cut (to move).
Open the folder where you want to paste the files / folders and Right click, Paste.

Figure 43: Move files

3.12. Delete files, folders to the recycle bin/wastebasket/ trash and restore to
original location. Empty the recycle bin/wastebasket/trash
Deleting Files



To delete a file, simply right click on it and click Delete. The same procedure applies for a folder.
Files and folders that you delete are placed in the recycle bin, from where you can permanently
delete a file or restore it.
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Figure 44: Delete files

To permanently delete a file / folder:


In the Recycle Bin right click on the file / folder that you wish to remove permanently, then click
on delete

Figure 45: Permanently delete a file / folder

Restore from Recycle Bin:




Double click on the Recycle bin to open it.
Right Click on the file or folder you want to Restore
Click Restore
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Figure 46: Restore from recycle bin

OR
In case you want to restore all of them:



Double click on the Recycle bin to open it.
Click Restore all

Figure 47: Restore all items from Recycle bin

To empty the Recycle Bin:



Double click on the Recycle bin to open it.
Click, Empty Recycle Bin.

Figure 48: Empty recycle bin
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